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 ميباشدPersian Designersليه حقوق این مقاله متعلق به نویسنده و سایت ک

داشته باشيد  ) 3  و 2 و 1شماره های ( قبل از مطالعه این مقاله توصيه ميشود تا مجددا نگاهی به مقالات قبلی 
رد نياز برای ساخت این نمونه تنها لوازم مو. تا اصطلاحات و مفاهيم بکار رفته در این مقاله برایتان نا آشنا نباشند

 و اندکی تلاش و پشتکار به همراه صبر و حوصله برای غلبه بر +5.0 ورژن 3d Game Studioداشتن نرم افزار
بنابراین بعد از حصول اطمينان از موجود بودن تمامی موارد مورد نياز ٬ مطالعه مقاله را . مشکلات احتمالی ميباشند

... آموزش داده شده در این مقاله را آغاز کنيدساخت نمونهادامه دهيد تا 

نکته مهمی که در همين ابتدا به آن اشاره ميشود اینکه مقاله ای که روبروی شماست به دو قسمت تقسيم شده 
در قسمت اول که همينک مشغول مطالعه آن هستيد از استفاده از کدها و بطور کلی برنامه نویسی پرهيز . است

اما در مقاله بعدی برای .  بعدی خود را بدون بکار گيری حتی یک خط کد خواهيد ساخت3ازی شده است و شما ب
افزودن بعضی از جزیيات مورد نياز مجبور به استفاده از کدها خواهيم بود و با بکار گيری چند خط کد در سطح ساده 

...٬ بازی را اندکی پيچيده تر خواهيم کرد

وشتن این مقاله فرض بر این گذاشته شده است که شما خواننده گرامی با اصول نکته نهایی اینکه در هنگام ن



با این وجود چنانچه .  آشنا هستيد و لا اقل نحوه ساخت یک اتاق را ميدانيد3D Game Studioاوليه کار با نرم افزار 
 Persianوانيد از سایت تمامی مقاله های ابتدایی را ميت. با این موارد آشنایی ندارید ترسی به دل راه ندهيد

Designer 3 و قسمت مقالات مربوط به نرم افزارDGSدر ضمن هر چند وقت یکبار پروژه خود را ذخيره . دریافت نمایيد 
!نمایيد تا در صورت بروز هر گونه مشکل کار را مجددا از اول آغاز نکنيد 

__________________________________________________________
______________________________________________________________

 را اجرا 3DGSبرای این منظور نرم افزار . بدون هيچ گونه توضيح و صحبت اضافی بسراغ ساخت این نمونه ميرویم
 را ایجاد مییک اتاق جدید  )  Ctrl+Nیا استفاده از کليد های ترکيبی  ( NEWميکنيم و با کليک بر روی گزینه 

 یک مکعب بزرگ را در وسط اتاق فعلی Object > Add Primitive > Cube ( Large )سپس توسط منو های . يمنک
بنابراین با .  معمولا این مکعب برای تبدیل شدن به یک اتاق بازهم اندکی کوچک به نظر ميرسد.کنيممان ایجاد می

سليقه شخص طراح دارد ٬ پيشنهاد ميگردد که با استفاده از دکمه توجه به اینکه ابعاد یک اتاق تماما بستگی به 
Scale Object موجود در Tool Bar یا استفاده از کليد S بعد از انتخاب مکعب مورد نظر ٬ ابعاد مکعب را اندکی بزرگتر 

) آن قرمز است رنگ ( بعد از انجام عمل تغيير اندازه در حالی که هنوز مکعب فوق الذکر تحت انتخاب است . کنيد
ملاحظه ميکنيد که با انجام این عمل مکعب .  را فشار دهيد تا این مکعب تبدیل به یک اتاق بشودAlt + Hکليد های 

سپس . علاوه بر این اینگونه به نظر می آید که مکعب دولایه شده است. تغيير شکل داده و اندکی حجيم تر ميگردد
 گانه نرم افزار ٬ تکسچر معمولی 4موجود در سمت راست پنجره های دابل کليک کردن بر روی آیکن تکسچر با 

:نتيجه کار تا به اینجا ميبایست مطابق شکل زیر باشد . آجری خاکستری را به دیواره های اتاق نسبت ميدهيم

ساخت یک اتاق به همراه تکسچر ساده اوليه

را که تنها از یک تکسچر بسيار ساده در آن استفاده چ. اتاق فعلی ما بسيار خشن و خشک و بی روح بنظر ميرسد
بنابراین در گام . شده است و هيچ کس از قدم زدن در اتاقی که هيچ روزنه ای به بيرون ندارد لذتی نخواهد برد

برای این منظور ابتدا فایل . بعدی از تکسچر های جدیدی برای کف و سقف و دیواره های اتاق استفاده خواهيم کرد
.  استاندارد خود نرم افزار را بارگزاری ميکنيم تا قادر باشيم از تصاویر موجود در آن در مراحل بعدی بهره ببریمتکسچر

Add Wad کليک ميکنيم و در کادر محاوره باز شده بر روی Texture > Texture Managerبرای این کار بر روی منوی 
3DGSت استاندارد تکسچر های بکار رفته در نرم افزار  فرمWadلازم به ذکر ميدانم که فرمت . کليک ميکنيم

در این هنگام از پنجره ظاهر . ميباشد و شما ميتوانيد که فایلهای زیادی را از سایت خود نرم افزار دریافت نمایيد
ملاحظه ميشود که بعد از انجام این.  کليک مينمایيمOpen را انتخاب ميکنيم و بر روی Standard.WADشده فایل 

بعد از . عمل نام فایل تکسچر در ليست ظاهر و تعداد تکسچر های موجود در آن در مقابل آن نمایش داده ميشود
اکنون ميتوانيم از تمامی تکسچر های سمت راست برای تزیين اتاقمان . انجام این عمل کادر محاوره را ميبندیم

ردن بر روی هر یک از تصاویر تمامی اضلاع اتاق به با کليک ک. اما در این ميان مشکلی وجود دارد. استفاده کنيم
. ولی ما ميخواهيم که تصاویر بکار رفته در سقف ها و کف اتاق متفاوت باشند. شکل تکسچر مورد نظر در ميآیند

س این اجرای کوچک را بطور  برای رفع این مشکل ميبایست اتاق فعلی را به اجزای کوچکتری تقسيم کنيم و سپ
 موجود در Scope Down و  Scope Upبرای تقسيم اتاق به اجزای کوچکتر از دو کليک . ینگ کنيمجداگانه تکسچر

Tool Barدر عين حال قادرید تا همين کار را از طریق منوی .  ميتوان استفاده نمودObject > Scope > … انجام 
 Tool Bar سپس از .آن تقسيم ميکنيم اتاق را به اجزای کوچکتر Scope downدر اینجا با کليک بر روی دکمه . دهيد
ملاحظه ميکنيد که . و بر روی اتاق چند بار کليک ميکنيم ) Mیا فشردن کليد (  را انتخاب ميکنيم Move Objectگزینه 

با کليک کردن بر روی نماهای مختلف موجود در تصویر قادرید تا . با هر بار کليک یکی از سطوح انتخاب ميشود
س با کليک بر روی تکسچر دلخواه آنرا تزیين کنيدتمامی وجوه را تک  در نهایت بعد از پایان . تک انتخاب کرده و سپ



 کليک کنيد تا دوباره اتاق را بصورت یک شیء مستقل Scope Uoعمليات تکسچرینگ مجددا و اینبار بر روی دکمه 
 را برای کف و چوب را برای چهار سبزهدر تصویر زیر من تکسچر آسمان را برای سقف و . در اختيار داشته باشيد

...دیوار کناری انتخاب کرده ام

تکسچرینگ وجوه مختلف اتاق

برای قرار دادن یک . ميرسدحال نوبت به قرار دادن مکان دوربين . تا به اینجای کار طرح اوليه اتاق به پایان رسيد
این دوربين را . د تا یک دوربين در تاق ایجاد شود کليک کنيObject > Add Positionدوربين در اتاق بر روی منوی 

نزدیک به . توسط دستور جابجایی اشيا که در بالا از آن استفاده کردیم تغيير مکان بدهيد تا در گوشه ای از اتاق 
:به شکل توجه کنيد . کف آن قرار بگيرد

قرار دادن دوربين در اتاق

 کليک کنيد تا Buildاکنون ميتوانيد بر روی گزینه . وليه اتاق به پایان رسيدتا به اینجای کار طراحی ا. بسيار خوب
در این هنگام تنظيمات و .  کليک کنيد تا پروژه اجرا گرددRunبعد از اتمام کامپایل بر روی . پروژه شما کامپایل شود

در اتاق باید چيزی تقریبا  بر حسب تکسچر های استفاده شده ...تيک های استاندارد را به هيچ وجه تغيير ندهيد
تا به اینجا که جالب . شبيه این شکل پيش رو داشته باشيد که قادرید تا در آن پرواز کنيد و به این ور و آن ور بروید

اینطور نيست ؟... بوده



اولين کامپایل مرحله

ر و راه رفتن بر روی زمين و دشمن و  هيچ خبری از بازیگ هنوزطرح ما تا به اینجا بسيار عالی پيش رفته اما... خوب
...گزینه ها خواهيم پرداختدر ادامه به ایجاد این . نيست... تير اندازی و 

استفاده نا صحيح از نور و . یکی از مهمترین عوامل در زیبایی یک مرحله استفاده صحيح و بهينه از منابع نور ميباشد
ث ميشوند که مرحله شما بسيار ابتدایی و ناشيانه به نظر برسد و بکار بردن نور های رنگارنگ و آزار دهنده باع

در عين حال بکار بردن نور زیاد به معنی استفاده . علاوه بر این بازیگر را از ادامه بازی در مرحله دلسرد خواهد کرد
ر این در ایجاد بناب. مضاعف از قدرت سخت افزار است و تاثير منفی در زمان اجرای بازی بر روند ن خواهد گذاشت

Object > Add Lightبرای ایجاد یک منبع نور در اتاق فعلی بر روی منوی . منابع نور نهایت دقت را به عمل آورید
سپس با استفاده از دستورات جابجایی آنرا تغيير مکان دهيد و به . کليک کرده و یک منبع نور را در اتاق قرار دهيد

برای تنظيم شدت نور آن ميتوانيد بر روی این منبع نور کليک . ف قرار دهيدمکانی در وسط صفحه و نزدیک به سق
 تغيير 2000 یا 1000 به عددی بزرگتر نظير 300 را از Range را انتخاب کنيد و مقدار اوليه Propertiesراست کرده و  

وماتيک نور استاندارد بازی از بين توجه داشته باشيد که بعد از قرار دادن اولين منبع نور در اتاق ٬ بطور ات. دهيد
بنابراین در صورت تمایل ميتوانيد . ميرود و شما ميبایست تمام نور پردازی در قسمتهای دیگر را خودتان انجام بدهيد
اشکال زیر به شما کمک . تا اندکی پيشرفت در طراحی مراحل از بکار بردن نور های اختصاصی خودداری کنيد

:ور را بدرستی تنظيم کنيد خواهند کرد تا منابع ن

 تنظيم شده است1500در این تصویر مقدار شدت نور بر روی 

MDL از مدل های تحت فرمت 3DGSدر ساخت بازی با نرم افزار . حال نوبت به ایجاد یک مدل در بازی ميرسد
مزیت های این فرمت اینست . داستفاده ميگردد که در سطح وسيعی و در بازیهای زیادی مورد استفاده قرار ميگيرن



به علاوه . در عين حال که حجم فایل نهایی بسيار کوچک ميباشد. که قابليت ذخيره انيميشن را هم در خود دارد
برای ایجاد یک مدل در بازی ابتدا به .  امکان پذیر استMDLقابليت ذخيره تکسچر نيز برای مدلهای تحت فرمت 

 را یافته و آنرا در Guard.mdlافزار را نصب کرده اید بروید و فایل موسوم به  در پوشه اصلی که نرم Workپوشه 
 این مدل قرار است که کاراکتر اصلی .پوشه ای که فایل های مرتبط با پروژه فعليتان را ذخيره کرده اید کپی کنيد

 آنرا باز کرده و این Medم افزار برای اینکه تصوری از قيافه این کاراکتر داشته باشيد ميتواند توسط نر. بازی ما باشد
 حال که این مدل را در پوشه فعلی ذخيره کردید به منوی . بعدی و از جهات مختلف بررسی کنيد3مدل را بطور 

Object > Load Entity بروید و مدل Guard.mdl را انتخاب کرده و بر روی آن دابل کليک کنيد تا یک نمونه از آن بطور 
در عين حال . سپس این مدل را تغيير مکان بدهيد و به گوشه ای از اتاق هدایت کنيد . رار بگيرداتوماتيک در اتاق ق

به . حتی الامکان این فاصله را به صفر نزدیک کنيد. توجه داشته باشيد که فاصله پاهای مدل تا زمين زیاد نباشد
:شکل توجه کنيد 

) توجه کنيد به مکان قرار گيری مدل( قرار دادن مدل در اتاق 

در اینجا ما نياز داریم تا به موتور بگویيم تا مدل ما را شناسایی کرده و آنرا در بازی نهایی بگونه ای کامپایل کند تا 
اما اینکار فقط با برنامه نویسی امکان . را به عنوان کاراکتر اصلی بازی داشته باشد... قابليت حرکت و تير اندازی و 

وجود در خود نرم افزار توابعی تعبيه شده ند که بازیساز را از نوشتن برنامه برای این کارهای با این . پذیر است
. بطوریکه شما قادرید تا با تنها چند کليک کار نوشتن چند صفحه کد را  انجام دهيد. ابتدایی و اصلی معاف ميکنند

ولی در . حرکت دادن کاراکتر استفاده نمایيدهرچند که قادر خواهيد بود تا در آینده کدهای اختصاصی خود را برای 
...حال حاضر به استفاده از توابع از پيش تعریف شده اکتفا ميکنيم و کد نویسی را به مقالات آینده واگذار ميکنيم

برای القای شعور مصنوعی به مدل گارد ابتدا باید یک اسکریپت جدید ایجاد شود تا کدهای مربوط به حرکت و 
 کليک ميکنيم و در کادر File > Map Propertiesبرای اینکار بر روی منوی .  کاراکتر در آن ذخيره شونداعمال مختلف

ملاحظه ميشود که اسکریپتی با نام فایل بازی ما و با فرمت .  کليک ميکنيمScript > Newمحاوره باز شده بر روی 
Wdlل گارد را انتخاب کرده و بر روی آن کليک راست مد. بعد از این عمل کادر محاوره را ميبندیم.  ایجاد ميشود

 Not(  آمده است ndefنوشته Actionميبينيم که در مقابل گزینه .  کليک ميکنيمPropertiesميکنيم و بروی 
Defined  ( بر روی این نوشته . به این معنی که در حال حاضر هيچ عملی برای این کاراکتر انتخاب نشده است

Slkill1سپس در مقابل گزینه .  کليک ميکنيمPlayer Move از دیدن ليست توابع موجود بر روی کليک ميکنيم و بعد
کار آخر را در صورتی انجام بدهيد که سيستم . (  را هم تيک ميزنيمShadow را وارد ميکنيم و در نهایت گزینه 1عدد 

.را یکبار ذخيره کنيدبعد از اتمام کارها کادر را ببندید و پروژه ) قدرتمندی داشته باشيد 

چنانچه از درستی تمامی کارها اطمينان حاصل کرده .  یکبار دیگر همه مراحل را چک کنيدBuildقبل از کليک بر روی 
 را تيک زده و عمل کامپایل High Res و Level Map – Preview کليک کنيد و تنها گزینه های Buildاید بر روی دکمه 
 Full کليک کرده و چنانچه تمایل دارید تا بازی در Runبعد از خاتمه عمل کامپایل بر روی در نهایت . را انجام بدهيد

screen اجرا شود گزینه Windows س مایليد تا بازی در حال پنجره ای اجرا شود این  را تيک نزنيد و چنانچه برعک
در محيط قدم بزنيد و به آسمان نگاه ... يد کليک کنيد و شاهکارتان را ببينGo در نهایت بر روی ....گرینه را تيک بزنيد

ز عالی بنظر يهمه چ...  بدویدShift زاویه دید بازی را عوض کنيد و با نگاه داشتن دکمه F7با استفاده از کليد . کنيد
اینطور نيست ؟.... ميرسد



تصویر نهایی از بازی

حال چکار کنيم ؟

اتاق های بيشتری را . را مجددا بازسازی کنيد و آنها را بزرگ یا کوچک کنيددر ادامه ميتوانيد با سليقه خود مراحل 
خلاصه اینکه مراحل جدیدی را با استفاده از . به بازی بيافزایيد و توابع مختلف اعمال شده بر کاراکتر را امتحان کنيد
س آنها را بریمان ارسال کنيد توسط مدیران بررسی و بازیهای شما .  خلاقيت و سليقه خود طراحی کنيد و سپ

در ضمن . امتياز دهی خواهند شد و اشکالات احتمالی و نقاط مثبت و منفی آن به شما اطلاع داده خواهند شد
بنابراین در تماس با ما و ارسال کارهایتان به هيچ وجه خصاصت نورزید و . کارهایتان به نمایش عموم در خواهند آمد

مدیران سایت از شما و کارهایتان به گرمی استقبال خواهند .  هایتان قرار دهيدحتما ما را در جریان کارها و پروژه
.کرد

...در صورت بروز هر گونه مشکل

در صورت بروز هر گونه مشکل در هر مرحله ای از ساخت ٬ کافيست تا در تالارهای گفتگوی سایت طراحان ایرانی 
مدیران و کاربران با تجربه در کوتاهترین .  راهنمایی بخواهيدمشکل خود را بيان کنيد و یا در مورد مساله ای خاص

ی شرکت در برا. فرصت ممکن پاسخ سوالاتتان را خواهند داد و شما را در مورد مشکلات راهنمایی خواهند نمود
... مراجعه کنيدWWW.Persian-Designers.COM/Forumان ایرانی به آدرسگفتگوهای تيم بازی ساز

 که تا به اینجا از مطالعه این مقاله خسته نشده باشيد اميدوارم

...باز هم با ما همراه باشيد

_______________________________________________________________

سایت طراحان ایرانی با هدف آموزش ساخت بازیهای کامپيوتری به زبان فارسی طراحی شده است و تا کنون 
مدیریت سایت از . ی در زمينه های مختلف برنامه نویسی و ساخت بازی در آن قرار گرفته استمقالات متعدد

تمامی عزیزان علاقمند به بازی های کامپيوتری ٬ برنامه نویسان ٬ طراحان و سایر کسانی که به نحوی با بازی ها 
ی و موثق در زمينه صنعت ساخت در ارتباطند ٬ دعوت به همکاری به عمل می آورد تا بدینوسيله یک پایگاه علم

.بازیهای کامپيوتری در ایران ایجاد گردد



در ضمن بسياری از نرم افزار های ساخت بازی های کامپيوتری که امروزه در سطح وسيع مورد استفاده قرار 
 های ميگيرند ٬ در سایت جمع آوری شده است و با مبلغ بسيار ناچيزی در اختيار علاقمندان به طراحی بازی

استفاده از این نرم افزار ها در آغاز کار و به منظور آشنا شدن با اصول اوليه در . کامپيوتری قرار داده شده است
طراحی بازیها بسيار موثر و مفيد بوده و شما ميتوانيد تا با چند جستجوی ساده در این زمينه ٬ به صحت موضوع 

تند که توسط فروشگاه الکترونيکی سایت به مشتاقان عرضه ليست زیر برخی از نرم افزار هایی هس. پی ببرید
:ميشوند 

Game Maker Version 5.0 –5.1 –5.2 –5.3 –6.0 ( Registered )
The Game Factory ( Home – Professional ) ( registered )
Xtereme 3D 1.0
King Space 3D
Genesis 3D V1.6
3D Game Studio 5.12
3D State ( Morfit 3D ) ( Registered )
Blender 3D
Q3d ( Unregistered )
Alice 3D
True Vision 3D V6.2
DirectX 9.0 Complete SDK ( Software Development Kit Package )

و کامپایلر های 

Visual Basic V6.0
Visual C++ V6.0

:لينک فروشگاه الکترونيکی سایت طراحان ایرانی 

WWW.Persian-Designers.COM/index.php?pid=1
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 قرار داردcom.designers-persian.wwwمقاله در اختيار نویسنده و سایت طراحان ایرانی تمامی حقوق این 
استفاده از مطالب با ذکر منبع بلا مانع است


